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Napster and Rhapsody compete for headlines

1 am a music glutton, so | have no trouble seeing how insanely great it is to get unlimited
access to an online jukebox with millions of songs for $10 a month. And as | said in the
last post, this kind of subscription service makes even more sense when you're always
connected to the Internet. But most people still seem to share Steve Jobs' don't-rent-
when-you-can-buy viewpoint, which obsesses on what happens when you stop
subscribing (i.e., you have no music to play) and ignores how much you're entertained in
the meantime. That attitude has made subscriptions a tough seli, and consequently
they've have been much slower to take off than a la carte offerings like the iTunes Store.
p— This week, two subscription services made
napste " announcement; that are mixed, gt best, for the
- cause of subscription services. First, the
potentially bad but not terribly surprising news:
Napster said it had hired UBS to help find a buyer. The company has last millions on its
slick, feature-rich subscription service, and has stayed alive by selling more and more
shares. But it's not starved for cash yet, and remains heaithy enough to field the market's
boldest customer-acquisition strategy: a free but lower-fidelity, non-portable version of its
service. Here's hoping that Napster finds a way to stick this strategy for a while longer
because an advertiser-supported online music service is a compelling proposition for
music fans. The catch is, it may not be compelling for advertisers until Napster attracts a
larger audience.
The other announcement was from RealNetworks, and it addresses the portability issue.
The early versions of Reaf's Rhapsody service, like Napster and competing offerings,
didn't let you move the songs you rent off of a computer. In other words, it didn't work in
the car. in the gym. on the train, or any other place frequented by people with white iPod
earbuds. That changed in 2004, when a new version of Microsoft's security software —
branded "PlaysForSure” by Redmond -- enabled subscription tracks to be moved to
portable devices on a temporary basis. If the user stopped paying the monthly
subscription fees, the tracks would stop playing. Naturatlly, the labels demanded higher
royaities for this service, so Rhapsody et al charged a higher price for it (typically, $15 a
month, although Yahoo charges about $10). But PlaysForSure didn't live up to its
moniker, and the portable services were plagued by glitches. Songs wouldn't transfer,
players would freeze, tracks would stop playing inexplicably, software would have to be
uninstalled and reinstalled repeatedly -- stuff like that. Critics said it was just too difficuit for
Mlcrosoﬁ‘s soﬂware to work with so many different services and players.
~ SoRealis attempting the kind of hardware-software
integration that helped make Apple so dominant in
~ digital music. On Monday, Real said SanDisk is
L optimizing one of its Sansa portable music players
to work with Real's Rhapsody subscription service,
using security software from Real instead of Microsoft. That means Real will control the
software both on the PC and inside the Sansa, a la Apple’s iTunes and iPod, Microsoft is
taking a similar approach with its new Zune players, which don't use PlaysForSure. either.
Making portability work the way it's supposed to is important, but | don't think that will
persuade the masses to embrace subscription services or abandon iPods. Sony has been
controlting both hardware and software for some time, and yet giant Sony's MP3 players
can't outsell (comparatively) tiny SanDisk’s. | think there are two problems here. One is
that people are daunted by the compatibility problems caused by the various flavors of
security software. If your downloads are wrapped in Microsoft's DRM, for example. you
can't transfer them to an iPod or a Sony MP3 player. The latest announcements about
Rhapsody and Zune threaten to exacerbate those problems and increase consumer
confusion. That leads rational consumers either to stay on the sidelines or to follow the
largest pack, which would be Apple's. And second, even if you get past the compatibility
hurdle, you still have to persuade people to shift from coilecting music (that is, buying
tracks) to experiencing it (buying access to a jukebox).
That tame is a marketing issne and none nf the servires has been able or willina to
1
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market subscriptions the way Apple markets {Tunes. But | give Real credit for doing some
things with SanDisk that will help make the sale. The players will come filled with rented
tracks. which with some luck will be chosen by the tuneful people who write Rhapsody's
blog. That's one way to get the point across immediately about the value of subscriptions:
look at all the songs you get, and you don't have to pay 99 cents per track! (As long as
you pay $15 a month ) More important, IMHO, is that Rhapsedy will automatically load
new music onto the player based on the subscriber's preferences. This capability could
trump one of iTunes' best features, which is to load iPods automatically with an
assortment of songs from your collection. Imagine if your collection was unlimited,
stretching from the week's new releases in your favorite genres to chestnuts buried deep
in the labels' vaults? Doesn't that make you want to ditch the iPod for a Sansa? Now if
only the tracks play for sure.... '

Postad by Jon Healey on September 20, 2006 in DRM , Music | Permalink

TrackBack
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Listed below are links to weblogs that reference Napster and Rhapsody compete for
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Comments

| don't understand why media writers keep discussing portability as if it is an obstacle,
There are so many programs out there, including Real's RealJukebox that allow a PC user
to record mp3's using "What U Hear" as the source. When | purchase a song from {Tunes
or any ather service, the first thing | do is play the song on my computer while running
Blaze Audio's RipEditBurn in record mode. i set the recording source to "What U Hear".
RipEditBum then records the song I'm playing on the computer in MP3, WAVE or
whatever format | choose. | now have a MP3 version of my song. | end up deleting the
proprietary version and playing the MP3 version anywhere | feel like playing it. This is so
easy. Why isn't this every discussed in articles like these?

Posted by: Adreana | September 20, 2006 at 03:54 PM

To answer Adreana's question -- using “streamripping” programs such as RipEditBurn to
create permanent copies (MP3s) of rented tracks (a k a. "tethered downioads,” the kind
provided by subscription services) violates the terms as well as the spirit of the deal.
Unlike the songs sold at iTunes for 99 cents each, the ones supplied by Rhapsody,
Napster and similar services come with no rights of ownership. You stop subscribing, you
no longer have the right to play those songs. The major labels (and many indies, |
suspect) insist that the temporary nature of the downloads be enforced technologically,
which is why the tracks come wrapped in security software such as Microsoft's or Real's
DRM. Unfortunately for all concerned, those DRMs have caused problems for many
subscribers who've tried to move rented tracks to PlaysForSure devices. it may be
tempting to solve these problems by using streamrippers to convert the tracks to WAV or
MP3 files, but subscribers don't have the right to do so.

Peosted by: Jon Healey | September 20, 2006 at 04:20 PM

I really dont understand the writer's view point of late all the so called writers are always
praising or indirectly prefer ipod Vs any of the competition These writers go at great
lenghts to explain over and over again about the DISADVANTAGES of non apple product.

All this proves to me that these media writers have lost objectivity.
They are aiways promting (POD.

Posted by: Av | September 21, 2006 at 12:21 AM

To Av: I'm a big fan of subscription-music services, as this post indicates, and such things
do NOT work with iPads. So while | appreciate how well iPods work, | don't think you can
view this installment of the blog as an advertisement for Apple.

Pasted by: Jon Healey | September 21, 2006 at 06:01 AM

Adreana’s rip-burning comment raises something ['ve always wondered about. { get
intellectually that the music crammed into my hard drive is not mine, that it's an nth
generation digital copy of an original creative moment and that the benefits of ownership
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entourage economy. But because I've committed treasure--and a little blood--to my iPod
infrastructure (video iPod, portable Altec speakers, Monster cablej ['ve bought into virtual
ownership. And like a ot of listeners, | have my own hybnid digital rights management
system with complex rules about when | buy, borrow and steal. So Adreana's feeling that if
she pays something to somebody she has the right to modify the form to fit her own
listening practices makes a lot of sense to me.

Posted by: Michael Soller | September 22, 2006 at 10:09 AM
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Software Notebook: Microsoft Zune doesn't do
'PlaysForSure’

New device diverges from the company’s partners
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Unveiling its Zune portable media player last week, Microsoft Corp.
sought to focus attention on all the whiz-bang capabilities of the new
device.

But just as notable is something the Zune doesn't do.

Microsoft says the device won't
play tracks or albums bought
through existing music services
affiliated with its own Windows
Media "PlaysForSure" initiative.
Those services -- such as Napster,
MTV's Urge and Yahoo Music
Unlimited -- have been partnering
with Microsoft and device makers
to try to challenge Apple
Computer's iPod and iTunes
juggernaut.

fsrosolt

& z00m
Zune.
The PlaysForSure program and

music services will continue even with the Zune's launch, Microsoft
says. But analysts say the rise of the Zune, and the device's
incompatibility with the PlaysForSure services, promise to further
reduce the potential market for those Microsoft partners.

The situation could be "very, very disruptive" for the existing
PlaysForSure services, said analyst Michael Gartenberg of Jupiter
Research.

"While Microsoft says that PlaysForSure is still a viable strategy going
forward, it's hard to see how viable it is given their reluctance to put it
in their own device," Gartenberg said. "It would probably not appear
that PlaysForSure has a very bright future."

The PlaysForSure strategy is to counter Apple by offering consumers a
range of devices and services from different companies, with a common
logo signaling compatibility.

It hasn't worked, at least not in terms of market share. Apple remains
the dominant force in digital music. That's why Microsoft has decided to
go out on its own with the Zune, related PC software, and the Zune
Marketplace for buying music to play on the device.
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The effects may also be felt inside other parts of Microsoft. For
example, the company's Windows Mobile team has aligned itself closely
with the PlaysForSure initiative, for playing music on Windows-based
smart phones and other mobile devices. ;

Microsoft's Zune team says its strategy -- focusing tightly on Zune
devices, related PC software and the online service -- is meant to
ensure a quality end-to-end experience. In that regard, the company is !
essentially adopting Apple's longstanding approach.
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Bryan Lee, a Microsoft corporate vice preside. .avolved in the Zune » more
initiative, said he believes Zune will maintain a "peaceful co-existence” -~ en
with the PlaysForSure partners. T

. AP BUSINESS HEADLINES
- Stacks fluctuate as market tries to assess
i economy

"I haven't heard any partners express their vision in the same way

we're doing it," he said. ¢ - Holiday Shopping Notebook: Interest-free
: financing
But some analysts say the Zune initiative poses a bigger competitive !« GM to lay off 1,600 workers at 3 factories

threat to the PlaysForSure offerings than to that of iPod and iTunes, at + Oil plummets on big jumps in US crude, gas

least initially. Van Baker, an analyst with Gartner Inc., estimates that ’ .Stlf"gﬁi 30 Income tumbles on weaker sales
the Zune could capture 15 percent to 18 percent of the portable music IR mor:

device market, particularly as the Zune lineup expands beyond the 30-
gigabyte model that Microsoft unveiled last week.

AP HIGH-TECH HEADLINES
- Treasury office faults IRS computer security

Coupled with the iPod's roughly 75 percent share of the market, that

doesn't leave much for other devices and services. . - Nokia 3Q profit falls 30 percent, revenue slips
¢ - Google appeals possible German ban on image

" : " . ; search

The rest will be relegated to everybody else," Baker said. | Review: Google's first phione smart, bt needs
t work

Then again, the competition is still playing out, and others don't appear | . EBay pasts 3Q profit, but outlook below

content to stand still. In July, after the Zune project was announced, ; forecasts

RealNetworks Chief Executive Rob Glaser spoke out against Microsoft's | »>more

decision to follow Apple's lead by offering its own music software,
service and device.

Seattle-based RealNetworks runs the Rhapsody music service, which is
affiliated with PlaysForSure and uses the related technology. Glaser
vowed a response to Microsoft's move.

i lqchs Falt 733 ?«\cy Min cu:‘Mo
H B et fo P
"Later this year, we plan to deliver consumer products and services that Conarmme: Woes '90 Lending
prove that a world-class, end-to-end music solution can be delivered
without one company doing everything,” Glaser said. He promised "to | »» more videos

work with our partners to market those services aggressively and ‘ . .

creatively to consumers."
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Zune launch sparks DRM fallout
November 20, 2006 at 04:50:00 PM REUTERS

Microsoft’'s move away from its PlaysForSure DRM format has
many of its longtime partners scrambling.

Microsoft unveiled its Zune digital music device and service to great fanfare
November 14, and already the fallout is being felt.

Few analysts expect the Zune,
which has received tepid reviews,
to have a significant impact in the
near term. But by launching its
own closed digital music system,
Microsoft has eroded what littie
confidence was left in its ability to
support PlaysForSure—its Zune, in three colors.
interoperable "ecosystem” of =

devices and services that uses

Windows Media Audio digital rights management (DRM) software.

Already, both existing and incoming digital music providers are looking for
alternate technologies to bring their services to market.

Sources say Amazon, which initially planned to launch a digital music
subscription service and Amazon-branded portable music device likely
based on Microsoft's DRM technology, has abandoned that modet in favor
of a DRM-free download service featuring unprotected MP3-formatted
music. This is the third time the company was poised to launch a digital
music service only to back away at the last minute.

Before Zune's launch, MySpace--which announced plans to Jaunch a music
service in early September--became another newcomer to the digital music
space that has opted to do without DRM. And Yahoo Music chief David

Goldberg has championed the need for DRM-free downloading for months.

MAJORS HANG TOUGH

Yet the major record labels continue to resist licensing their music to
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services that don't feature DRM protection, nmiting these services to lesser-
known tracks from independent labels.

Meanwhile, last month, Rhapsody partnered with SanDisk to install its own
DRM technology--called Rhapsody DNA--into the new Sansa Rhapsody
device. The Rhapsody service still supports other PlaysForSure devices,
and the Sansa Rhapsody device is compatible with competing subscription
music services. But the two work best together, enabling faster music
transfer speeds and the addition of music recornmendations from
Rhapsody editors.

Rhapsody plans to include the DNA software in additional devices, and
could eventually eliminate Microsoft technology altogether.

Even Microsoft's own PlaysForSure service, the MSN Music Store, is being
phased out in favor of Zune. While the service remains operational,
purchases are redirected to either Rhapsody or the Zune store, and
eventually will be shut down completely.

Microsoft's decision to launch Zune as a closed service and the industry's
reaction to it are symptoms of the PlaysForSure strategy's inability by itself
to get the job done.

"Making the consumer experience the best it can be is our priority,” Zune
general manager of marketing Chris Stephenson says. "The consumer
needs to know that their product is going to work. It's a buy-with-confidence
scenario.”

TECH TROUBLES

Stephenson admits the PlaysForSure system was supposed to do exactly
this, but that the community has not yet "found its full footing.” While
PlaysForSure devices and services should work together in theory,
frustrating integration problems often arise between them.

PlaysForSure partners blame Microsoft for providing faulty technology, with
one executive calling its support program "awful." Napster, Urge, and
Yahoo--like Rhapsody--are all working more closely with device
manufacturers to provide better integration with their services.

"We don't think closed systems are the solution," Yahoo's Goldberg says.
"We are working to solve all of users’ needs, not just those with a particular
piece of hardware.”

Some partners hope that Microsoft will fix the bugs in its DRM technology
now that it has to use the software itself for Zune. But there is also a good
chance that new music services in the future will launch using a closed
model similar to Zune and iTunes. Samsung, for instance, is prepping a
music service designed specifically for its devices, and already wireless
operators like Sprint and Verizon Wireless have introduced closed systems.

The music industry, however, has expressed concern about more closed
systems at the expense of interoperability.

"We are no happier about the closed envircnment that Microsoft just

2
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announced than we are about Apple's,” one major label executive says.
For the most part, though, Microsoft's customers are taking a wait-and-see,
business-as-usual approach. Much of their reaction will depend on the
Zune's success.

Microsoft would not reveal how many units it has shipped or its sales goals.
The most aggressive forecast comes from ABI Research, which predicts
Microsoft will sell about 500,000 devices by the end of the year.

But Microsoft's goal is to gain second position behind Apple Computer for
both market share and mind share in the digital music race. According to
data from the NPD Group, today's MP3-device market share race features
Apple in the lead with 75 percent of the market, followed by SanDisk with
10 percent, Creative Labs and Sony at 2 percent each, and all others
combined for 7 percent.

According to Jupiter Research analyst Michael Gartenberg, any success
Microsoft has in reaching its goal will come at the expense of its existing

partners.

"Whatever Microsoft gains is not going to come from App!e’s (market
share), but it's going to come from the other guys,” he says.

Story Copyright © 2008 Reuters Limited. All rights reserved.
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iTunes 3: How to Convert Song to a Different Format

Last Modified: Augu
Article: HT 2427

Old Adicle: 51060

Summary
This document explains how to use iTunes to convert a song to a different format.

Products Affected
Tunes

iTunes can convert a song from one format to another. For example, you can convert a song from a WAV file format to an MP3
file format.

How to convert a song

1. From the iTunes menu, choose Preferences.
2. Click the Importing icon.

3. Choose the encoding format that you want to convert the song(s) to from the Import Using pop-up menu. (See the "About
compression” section below.)

4. Click OK to save the settings.
5. From the Advanced menu, choose Convert To (AIFF, MP3, or WAV depending on the preference you chose in step 3).

6. Choose the song, folder, or disk that contains the songs you want to convert. If you choose a folder or disk, all the songs it
contains will be converted.

About compression

When you convert a song, some data may be lost due to the way certain formats compress data. For this reason these formats
are sometimes called "iossy" formats. The advantage of using a "lossy” format is that the file sizes are much smaller, which
means you can store more songs in the same amount of disk space. The disadvantage is that the sound quaiity may not be as
good as the original, uncompressed format. Depending on the song, the speakers or headphones, and the player you use to
piay the song, you may not be able to tell the difference between a compressed "lossy” song and a song that is not
compressed.

Once a song is compressed (meaning some of its data is lost) you cannot retrieve the data by uncompressing it. If you convert a
song from a "lossy" format to a uncompressed format, the quality of the song will not improve and the file will only take up more
disk space. For example, if you convert a song in MP3 format (a compressed format) to AIFF (an uncompressed format) the
song will take up much more space on the hard disk, but it will still sound the same as the compressed file. In order to take
advantage of uncompressed formats you should only import songs using these formats.
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iTunes for Windows 7.6 Help

‘Q Creating your own audio CDs
To make your own CD, you need:

a
A computer with an internat disc drive that can burn CDs (CD-RW or SuperDrive), or a compatible external drive. (To see if your
drive is compatible, choose Edit > Preferences, click Advanced, and click Burning. If your drive is listed, it's compatible.)

n
A blank CD. If you pian to play the CD on a consumer CD player (not only on a computer), you need to use a blank CD-R disc,
not a CD-RW disc.

L

An iTunes playlist containing the songs you want on the CD. You can fit about 74 minutes of music (about 20 songs) on a 650
MB CD-R disc. Some discs can contain 80 minutes (700 MB) of music. (You can see the size of the selected playlist at the
bottom of the iTunes window.) For instructions on creating a playlist, search help for "creating lists of songs.”

To create an audio CD:

a

Choose Edit > Preferences, click Advanced, and click Burning.

a2

Select Audio CD as the Disc Format.

8

To have all the songs on the CD play at the same volume, select Use Sound Check.

@

Click OK.

. <
Select the playlist containing the songs you want to burn to the CD, and make sure ali the songs you want to
include on the CD have a checkmark beside them.

&

Click Burn CD (at the botiom of the iTunes window) and insert a blank disk.

If the playlist contains more songs than will fit on the CD, iTunes burns only the number of songs that fit on one
disc, and then asks you to insert another disc to continue burning the remaining songs.

If the playlist includes Audible spoken programs with chapter markers, the chapters are burned as separate tracks.

it might take several minutes to burn an audio CD. You can cancel the burn by clicking the X next to the progress bar (but if
you're using a CD-R disc, you won't be able to use it again).

If the playlist contains iTunes Store purchases that are not iTunes Plus songs, you can burn the playlist to a CD up to seven
times.

Open

Apple Support article: "Additional troubleshooting for buming issues”

Keywords: khelp kituneswin

Did this article heip you?

It solved my issue...
Tell us what works for you.

It's good, but...
Report typos, inaccuracies, etc.



http://docs.info ~~nle.com/article.html?path=iTunesWin/~ ~/en/15323.html

It wasn't helpful...
Tell us what would have helped.
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Adding Content to iTunes

Last Modified:

Article: HT
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Summary

Adding audio and video content to iTunes is easy. iTunes lets you import audio CDs, add digital audio and video content already
on your computer and even purchase new content from the iTunes Store. To learn more about adding content to iTunes, select
a topic below. If you already have content in your iTunes library and want to fearn more about playing and managing content,
see article HT1399.

= Adding songs from audio CDs
s Adding content on your computer to iTunes

s Purchasing content from the iTunes Store

Products Affected
iTunes Store, iTunes 7 for Mac, iTunes 7 for Windows, iTunes & for Windows. iTunas 8 for Mac

Add songs from audio CDs

Using iTunes, you can add music to iTunes from your audio CD collection in few easy steps. Follow these steps to learn more.

1. Open iTunes and insert an audio CD into your computer's CD or DVD drive.

2. If your computer is connected to the Internet, iTunes will automatically look up information for the CD such as song name,
album and artist. This feature will work with most commercially produced audio CDs.

3. To import all songs from the CD into your iTunes library, simply click the "Import CD" button in the lower right hand corner
of the iTunes windows. If you prefer to import only a few songs, uncheck the checkbox next to the songs you don't want to
import and then click "Import CD".

11 = o the Highways ereant O B
9

18 %1 Lonesome Valley 4:07 O Brother, Where Art Thou?

E

19 Angel Band 2:16 O Brother, Where Art Thou?
19 50N@s, 1 hour 611 5 M8 _ | :.-nnort ’9 J | _;

4. iTunes will show the progress of the import for each song selected. iTunes encodes content imported from audio CDs in
AAC format at 128 kbps. This format provides high quality sound at small file sizes. If you prefer to encode content from
audio CDs in MP3, WAV, AIFF, or Apple Lossiess format or you want to convert a song you've already imported to a
dlfferent format see article HT1550
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Adding content on your computer to iTunes

iTunes lets you add digital audio and video files on your computer directly to your iTunes library. You can add audio files that
are in AAC, MP3, WAV, AIFF, Apple Lossless, or Audible.com (.aa) format. If you have unprotected WMA content, iTunes for
Windows can convert these files to one of these formats. Video content in QuickTime or MPEG-4 format can also be added to
iTunes. To learn how to add these files to iTunes follow the steps below.

1. OpeniTunes

2. From the File menu, choose one of the foliowing choices:
s Mac
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s Add to Library

s Windows
= Add File to Library

m Add Folder to Library

3. Navigate to and select the file or folder that you want to add

If iTunes is set to "Copy files to the iTunes Music folder when adding to library”, iTunes will copy all content that is added to the
iTunes library to the iTunes Music folder. The adjust this setting or change the location of this folder, go to the Advanced tab in

iTunes preferences.

Purchasing content from the iTunes Store
The iTunes Store has a large selection of music, movies, TV shows, audiobooks, iPod games, and free podcasts. To learn more
about purchasing and downloading content from the iTunes Store, see article 304673.



